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Background and Objectives: Compression spinal cord injury is a highly 
heterogeneous lesion, and tools to delineate pathophysiological recovery needed. 
Our objective was to profile the protective or reversal effects of RKI-1447 on neuron 
regeneration and its correlation with the degree of tissue damage in the rats with 
induced compression injury at the T7 level. Methodology: Albino rats of Sprague 
Dawley strain, 08 weeks of age, weighing 250 +10gm (n= 64) were used in this study. 
The animals were procured from the Animal House of Khyber Medical University, 
IBMS campus. Every experiment was carried out following a protocol that the 
Institutional Animal Ethics Committee authorized in 09.09.2020 under the (DIR / 
(KMU AS & RB/BD/001187) under the 89th meeting. The study duration was for 03 
years, in which the histological studies took 06 months. Two groups of animals were 
formed. The experimental group and the control group (A). The experimental groups 
were further divided into four subgroups i.e. B, C and D. Group A was a sham group, 
in which rats were incised at level T7 only. Spinal cord compression injury at T7 level 
was performed in groups B, C and D. Group B was treated only with placebo while 
the group C and D, were treated with RKI-1447, with a dose of 0.3 and 0.6 µg/kg/b.w. 
respectively. For histological analysis, the animals were sacrificed 7, 14 and 28 days 
after the completion of behavioral studies. The staining pattern of glial fibrillary 
acidic protein (GFAP) for Astrocytosis/Reactive astrocytes, GAP-43, for Axonal 
growth/sprouting and Neu N for neuronal number for viability of neurons were 
observed. Results: All the group animals were evaluated daily after surgery. 
Consequently, our research showed that rats in group A healed quickly with just the 
Laminectomy procedure. In experimental rats, both groups C and D showed 
improved behavioral and histological results. In contrast, group B demonstrated 
sluggish and inadequate recovery. Additionally, group D rats showed superior 
performance in behavioral assessments, and their histological scores significantly 
surpassed those of group C. Group "D" excelled over group "C," probably because of 
the high dosage of RKI-1447 (0.6 µg/kg) administered to group D. Regarding the 
time-related effects of RKI-1447, the 28-day survival treatment yielded promising 
outcomes compared to the 14-days treatment. Conclusion: The current research 
presents evidence suggesting that both functional and morphological outcomes 
following spinal cord compression injury can progress in a discontinuous, non-linear 
fashion, despite the injury levels being graded in a linear manner. Serum levels of 
GFAP, GAP-43 and NeuN, may serve as potential biomarkers for assessing the 
severity of traumatic conditions and traumatic limb injuries. However, further 
animal studies are necessary to translate these findings into clinical applications. 
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INTRODUCTION 
Spinal cord injuries are life-altering conditions, with the 
first few days being the most crucial and the secondary 
complications being the leading cause of mortality and life-
threatening.1 
Spinal cord injury is a life disrupting conditions in which 
the initial days are the most critical conditions while 

secondary complications are the life threatening and the 
main cause of death.   Many spinal cord injury studies 
conducted so far have focused on a small range of injury 
levels, often if the outcomes—whether functional, 
histological, or neurophysiological—progress in a 
consistent, graded manner as the severity of the injury 
increases.2  
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Spinal cord injuries are a major health concern that 
significantly impacts a person's quality of life. These 
injuries lead to profound effects not only on the individuals 
affected but also on their families and society, as they often 
result in severe disability. Traumatic spinal cord injuries 
are lifelong conditions that require ongoing attention to 
minimize their long-term effects.3  
Individuals with spinal cord injuries experience a loss of 
sensory input and motor function due to the inability of 
damaged neurons and nerve fibers to transmit or generate 
signals. This damage leads to permanent sensorimotor and 
autonomic impairments. The progression of both primary 
and secondary spinal cord injuries occurs in distinct 
phases, including immediate, acute, subacute, 
intermediate, and chronic stages.4  
The CNS contains a variety of glial cells, including 
oligodendrocytes, radial glia, Muller cells, resident and 
perivascular microglia, and astrocytes. In 1969, Dr. Eng 
identified and described glial fibrillary acidic protein 
(GFAP), a unique structural protein that distinguishes 
astrocytes (astroglia).5 
GFAP (Glial Fibrillary Acidic Protein) monocl5nal antibody 
is used for the detection of reactive astrocytes surrounding 
the damage area of spinal cord. It’s a type III gene protein 
which forms the cytoskeleton of the astrocytes.6 
It is one of the fine markers for activated astrocytes. It also 
plays a vital signaling system that responds to different 
stressful conditions by regulation, migration and survival 
of cells via GAP-43 (Growth Associated Protein 43) 
Recombinant Rabbit Monoclonal primary antibody was 
used for the detection of axonal sprouting/growth in the 
injury site of spinal cord. This gene encodes a protein which 
has been labelled as a “growth or plasticity” protein because 
its expression is higher i neuronal growth cones 
throughout development and axonal regeneration 
process.7  
This protein is considered as one of the most fundamental 
elements of an active regenerative response in the 
neuronal axons in nervous system. GAP-43 is a specific 
neuron protein and an important component of growth 
cone in axons. It is engaged in the axonal regeneration, 
neuronal growth and stabilization of synaptic functions. It 
also plays an important role in learning and memory 
functions of CNS.8 
Neu N was initially introduced in 1992 by Mullen and 
colleagues, who developed a set of monoclonal antibodies 
targeting mouse antigens. Their primary goal was to 
identify immunological markers specific to mice, which 
could be used in transplantation studies.9  
Neu N antibodies are commonly utilized to identify 
neurons, although they have some limitations. A PubMed 
search conducted in June 2024 using the term "Neu N" 
yielded more than 5000 results. Neu N immunoreactivity 
becomes more pronounced as neurons mature, usually 
following the downregulation of Doublecortin, a marker 
associated with the early phases of neuronal 
development.10  
Spinal cord compression is a serious neurological 
condition that requires prompt and effective intervention 
to prevent permanent damage. The aim of this study is to 
evaluate the therapeutic potential of RKI-1447, a selective 
Rho-associated coiled-coil containing protein kinase 

(ROCK) inhibitor, which has shown promise in reducing 
inflammation and promoting neural recovery. By 
investigating the effects of RKI-1447, particularly at higher 
doses, this study seeks to explore its efficacy in improving 
outcomes following spinal cord compression.11 

Objectives 
The objectives of the study were: 
• To evaluate the role of RKI-1447, in the reversal of 

inflammatory process in injured spinal cord. 
• To assess the role of RKI-1447, in the recovery of the 

spinal cord injury 
 

MATERIAL AND METHODS 
The institutional ethical review board and the biosafety 
office of Khyber Medical University, IBMS Peshawar, gave 
their clearance for this lab-based experimental study. This 
experimental study was conducted in Khyber medical 
university IBMS campus pathology department and 
anatomy department. The rats were euthanized and kept 
for the tissue processing on which the antibodies were 
applied accordingly. 

Animals 
A total of 64 Sprague-Dawley rats, each with a weight range 
of 250+10 gm, were utilized in the investigation. The 
sample size was determined based on the resource 
equation method, which accounts for multiple behavioural 
observations and a single observation for molecular 
studies and histology. The rats were raised in cages with 
four rats each, and their light and dark cycles lasted for 
twelve hours. The rats had unlimited access to food and 
water, and the room temperature was kept at 22°C. Before 
the study started, they were given a week to get used to the 
living arrangements. 

Grouping 
Two main Groups were made to conduct the study. The 
sham group (Labelled as A), and the second group was 
experimental compression group which was further 
subdivided into groups B, C and D. Group B was treated 
with normal saline after compression while groups C and 
D received 0.3 µgm and 0.6 µgm doses of RKI-1447 daily, 
respectively. 
The animals were kept under treatment and observation 
for three intervals i.e: 07th day, 14th day and 28th day. After 
their Behavioral studies12 the animals were euthanized 
and were processed for Histological studies. 

Optical Density 
The optical density of GFAP, GAP-43 and Neu N expression 
were evaluated as an estimate of the quantity of 
immunopositively cells in the SCIs. Images were acquired 
at 40 X, 100X and 200X µm magnification on a Nikon E600 
light microscope from three sections in each slide.13  
Using Image-J and digital images, the injured area showed 
was identified. The mean gray values from three randomly 
chosen locations with or without immunoreactivity were 
used to calculate the background gray levels. By dividing 
the total immunoreactivity areas by the total area of the 
relevant sub-regions on the three sections, the total optical 
density value for each brain was determined.14  
The Image J software, also known as Fiji, was employed to 
analyze the images that were acquired from the compound 
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microscope. The Optical density (OD) was employed to 
determine the average and standard deviation (SD) of the 
antibody expression intensity in each group. Meanwhile, 
GFAP, GAP-43 and Neu N, this method was used to 
determine each study group's mean and standard 
deviation of the total cell count. Using ImageJ software, the 
mean cell count was determined by following these steps:  
(Select image > set to 8-bit > Image > Adjust > Threshold 
(set minimum to 85 and maximum to 255) > Process > 
Make Binary > Convert to Mask > select areas > Analyze > 
Particles.) 
The results were then exported to Excel and SPSS software 
for further analysis. (https://youtu.be/1PQprFZ2Byg, 
https://www.unige.ch/medecine/bioimaging/files/3714
/1208/5964/CellCounting.pdf).  
Optical density was calculated using a validated protocol in 
ImageJ: first, record a macro by selecting Image > Plugin > 
Macro > Record, and then draw a rectangular shape on the 
image. Save the macro item and proceed by opening the 
images individually from the file, selecting Image > Color > 
Deconvolution > H-DAB, and using Color 2 for intensity 
quantification. Then, select Plugin > Run > Macro.ijm and 
finally go to Analyze > Measure. The results were saved in 
an Excel sheet. 
(https://www.researchgate.net/post/Does-anyone-have-
a-protocol-for-quantifying-IHC-images-in-ImageJ).15  
The optical density was computed using the following 
formula: The maximum intensity for each 8-bit image is 
250, and OD is equal to log (maximum intensity / mean 
intensity). 

Staining and Immunohistochemistry 
The steps conducted for staining followed by IHC are 
sectioning the SCI site and then the slides preparation. 
Slides 3, 6, 9, 12 and 15 were chosen from each spinal cord 
tissue section to measure the average number of viable 
neurons in damage lesions out of about 15 slides of each 
specimen that were processed in a sequential order. GFAP, 
GAP-43, and NeuN monoclonal antibodies were used in 
1:50 dilution to detect change in astrocytic count, normal 
viable neurons, and neuronal count in spinal cord injury 
sites.16 

Microscopy & statistics 
For immunohistochemistry, slides number 3, 6, 9, 12 and 
15 out of total slides were selected from each spinal cord 
tissue specimen to evaluate average measure of reactive 
Astrocytosis by using GFAP antibody, Axonal growth in 
injury site by GAP-43 antibody and noticeable viable 
neurons in the injury site by NeuN antibody. Each antibody 
was applied to one section per slide due to the three tissue 
sections on each slide. Hydrophobic barriers were made by 
PAP pen (ab2601, Abcam UK) between the sections to 
prevent mixing of antibodies and other reagents used 
during staining process. The commercially available IHC 
kit (Dako, En Vision TM FLEX Mini Kit, High PH, Code# 
K8024) was utilized for IHC staining. 
The following materials (solutions and reagents) were 
provided in the kit.17 

Peroxidase Blocking Agent 
Phosphate buffer including hydrogen peroxide, 15 mmol/L 
NaN3 and detergent. 

• HRP: - Dextran combined with goat secondary 
antibody molecules and peroxidase molecules to 
combat mouse and rabbit immunoglobulin in a 
buffered solution including a preservative and 
stabilizing protein. 

• DAB+ Chromogen: Tetrahydrochloride of 3-
diaminobenzidine (in organic solvent). 

• Substrate Buffer: - hydrogen peroxide and 
preservative in a buffered solution. 

• Target Retrieval Solution, High pH (50x 
concentration): - Tris/EDTA buffer, pH 9. 

• Wash Buffer (20x concentration): - Tris buffered 
saline with, pH 7.6. 

• Antibody Diluent: - Protein and 15 mmol/L NaN3 are 
present in Tris buffer, which has a pH of 7.2. 

After applying the antibodies to the slides, microscopic 
examination was conducted using a Nikon Eclipse 80i 
microscope at magnifications of 10X, 40X, and 100X. 
Multiple attempts were made at each magnification to 
capture clear and precise images. Viable neurons within 
the injured region were examined and quantified through 
optical density analysis using ImageJ Fiji software. 

Table 1 
Details of Primary Antibodies Used in 
Immunohistochemistry. 

Antibody Supplier 
Species 

Reactivity 
Host/ 

Isotype 
Class Clone 

GFAP 
Thermofisher 

Scientific 

Human, 
rats, pig 

and 
chicken 

Mouse/ 
IgGIM 

Monoclonal 
ASTR-

06 

GAP43 
Invitrogen 

Thermofisher 
Scientific 

Human, 
Mouse and 

rat 

Rabbit 
/IgG 

Recombinant/ 
Monoclonal 

SC60-
06 

Neu N 
Invitrogen 

Thermofisher 
Scientific 

Mouse 
Rat / 
IgG1, 
kappa 

Monoclonal A-60 

Statistical Analysis 
Microsoft Excel 18 and SPSS version 25 were used for the 
statistical analysis. Descriptive statistics were computed 
using means and standard deviations. The Kruskal Wallis 
test was employed to make comparisons across the groups. 
Additionally, the ONE WAY ANNOVA test was utilized to 
conduct comparisons between the individual groups (with 
a P value of less than 0.05 being deemed statistically 
significant). All data appears as the mean ± SD, with a 
significance level of p < 0.05. 

RESULTS 
At regular postoperative intervals, the rats were 
meticulously monitored. Rats were acting a little drowsy, 
sleepy, and inactive during the first few days after surgery. 
They also consume less food and liquids. Some rats 
displayed dark crimson secretions from their eyes and 
nostrils on the first to third post-operative days.  
With each passing day, the rats' activity levels 
progressively increased, and their food consumption 
returned to normal. The activity levels of the rats in group 
C, and especially in group D, showed much greater 
improvement compared to those in group B.  

Reactive Astrocytes Count (Glial Scar Outer Core) 
It was found that as the severity of the trauma increased, 
there was a rise in the number of apoptotic cells, especially 

https://youtu.be/1PQprFZ2Byg
https://www.unige.ch/medecine/bioimaging/files/3714/1208/5964/CellCounting.pdf
https://www.unige.ch/medecine/bioimaging/files/3714/1208/5964/CellCounting.pdf
https://www.researchgate.net/post/Does-anyone-have-a-protocol-for-quantifying-IHC-images-in-ImageJ
https://www.researchgate.net/post/Does-anyone-have-a-protocol-for-quantifying-IHC-images-in-ImageJ
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GFAP (+) protoplasmic astrocytes in the perilesional area 
of the cortex. After processing the tissue and applying the 
GFAP antibody to tissue sections, reactive astrocytes were 
counted around the injury site using optical density.  
To compare the reactive astrocyte counts within the 
groups, the Kruskal Wallis test was used. Significant 
differences in astrocyte counts were observed between 
groups B and A, and C and D, as shown in (Figure 2). This 
indicates that there was greater astrocyte reactivity 
around the injury site in the 28-day groups compared to 
the 14-day groups. Reactive Astrocytosis increased in 
group C and D which were treated by RKI-1447. 
These results suggest that the non-RKI-1447 treated group 
showed more reactive Astrocytosis around the injury, 
forming a denser outer core of the glial scar compared to 
the RKI-1447-treated groups. Additionally, the data also 
highlights the greater effectiveness of a higher dose of RKI-
1447 (0.6 µg/kg/day) compared to a lower dose (0.3 
µg/kg/day) in reducing reactive Astrocytosis.  

Figure 1 
- 5 μm thick rat spinal cord longitudinal sections showing 
IHC staining for the expression of GFAP in reactive 
astrocytes, at 10X, 40X prominent injury site marked by 
black lines can be appreciated. Highly proliferated 
astrocytes with increase in number, size and GFAP content 
around injury lesion, are marked. 

 

GAP-43 (Axonal Growth or Sprouting) 
After tissue processing and the application of the GAP-43 
antibody to tissue sections, the injury site was analyzed, 
and axonal growth sprouting was quantified using optical 
density. This was done by measuring the intensity of the 
area occupied by axonal sprouting at the injury site across 
multiple attempts on each slide.  
To assess differences in the intensity of the total injury 
area occupied by axonal growth/sprouts within the 
groups, a ONE WAY ANNOVA test was used. Significant 
differences were observed in the axonal growth at the 
injury sites between groups A and B, C and D, with P values 

of P = .007, P = .028, and P = .009, respectively (Figure -2). 
These results confirm that there was greater axonal 
growth in the injury sites of the 28-day groups compared 
to the 14-day groups. 

Figure 2 
- 5 μm thick rat spinal cord longitudinal sections showing 
IHC staining for the expression of GAP-43 in Axonal growth, 
at 10X, 40X prominent injury marked by black Boxes can be 
appreciated. More axonal growths/sprouts can be identified 
in group “D” compared to group “B” which indicates increase 
in axonal growths/sprouts in injury lesions, as the injury 
progresses from acute to chronic stage. 

 

These images indicate that there was less axonal 
growth/sprouting in the injury site of not treated group as 
compared to RKI-1447 treated groups. These results also 
reveal the effectiveness of RKI-1447 in a higher dose of 0.6 
µg/kg/day as compared to lower dose of RKI-1447 0.3 
µg/kg/day to enhance axonal sprouting more in the injury 
site, after spinal cord injury, shown in figure -2. 

Neu N (Viable Neuron Count) 
After applying the NeuN antibody to tissue sections, viable 
neurons at the injury sites were examined. But only some 
residual neuronal cell bodies were detected, but no 
normal, viable neuronal cell bodies were found at the 
injury site in any group except for the non-compression 
group i.e: Group A. As a result, no statistical data regarding 
neuronal viability or functional neurons within the injury 
site post-spinal cord injury was obtained.  
Optical density was used to estimate the optical density of 
neuronal cell body residues inside the entire damage area 
for each participant in all groups. In the injury lesion, we 
observed the presence of residues and traces of neuronal 
cell bodies across all the groups. There was a clear 
distinction in the number of neuronal residues between 
the RKI-1447 treated group and the non-RKI-1447 treated 
group. Our study also unveils the efficacy of RKI-1447 in a  
higher dose of 0.6 µg/kg/day as well as in lower dose of 0.3 
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µg/kg/day in both 14 days and 28 days duration.  
These remaining neuronal bodies were more noticeable in 
28-day subgroups than in 14-day subgroups within the 
groups. shown in figures -3.  

Figure 3 
- 5 μm thick rat spinal cord longitudinal sections showing 
IHC staining for the expression of Neu N in Neuronal Count, 
at 10X, 40X prominent injury site marked by black lines can 
be appreciated. Neuronal content around injury lesion, are 
marked. 

 

Figure 4 
- Comparison of the mean and standard deviation between 
groups at various points in time, such as 7th, 14th and 28 days 
after the rats were placed to sleep and their histological 
parameters were examined. (I) represents SDEV. The P value 
from the Kruskal Wallis test is less than 0.05 across all 
groups. 

The Graph shows that RKI-1447 treatment had a time-
dependent and dose-sensitive influence on the evaluated 
outcome after compression injury, according to the 
graphical analysis conducted over 7th, 14th, and 28th days. 
On day 7th, the compression-untreated group displayed the 
lowest mean value, demonstrating the detrimental effects 
of compression damage, whereas the sham group 
displayed the highest mean value, showing normal 
baseline function.  
All groups showed a time-dependent reaction to RKI-1447 
therapy after compression injury (Figure -4). 
In comparison to the sham group (A), all compression 
groups (B, C, and D) displayed lower outcome values on 
Day 7, suggesting an early injury-related deterioration. 
Nevertheless, there was no statistically significant 
difference between any of the treatment groups, indicating 
that neither RKI-1447 dose had a meaningful short-term 
impact at this point. 
By Day 14, the therapy response became more apparent. 
While all compression groups, including untreated (B = 
1.001), low-dose RKI-1447 (C = 0.964), and high-dose RKI-
1447 (D = 1.014), were considerably lower than sham (p < 
0.05), the sham group (A) maintained the greatest mean 
value (1.918). This demonstrates that compression has a 
long-lasting detrimental effect and that by day 14, neither 
RKI-1447 dose had a discernible protective effect. 
All compression groups, including treated ones (C = 0.906, 
D = 1.039), continued to exhibit statistically significant 
decreases in comparison to sham (p < 0.05), while the 
trend remained constant on Day 28: sham values remained 
at their greatest (mean = 1.089). The low-dose RKI group 
(C) notably improved slightly compared to the untreated 
group (B = 0.889), but this difference was not statistically 
significant. 
The compression-untreated group continuously 
performed the worst during the study. With the 0.3 µg 
therapy offering the most long-term benefit, these results 
point to a non-linear, delayed therapeutic effect of the 
lower RKI-1447 dose, underscoring the significance of 
dose selection and time in attaining the best possible 
recovery after compression damage. 
 

DISCUSSION 
Spinal cord injuries are a significant concern that has long 
been the subject of research. These injuries involve both 
initial and subsequent damage, with the focus of treatment 
being to prevent or reduce further harm. Within hours of 
the injury, macrophages are activated and release various 
inflammatory substances, including TNF-α, IL-6, IL-1β, CD-
16, CD-32, and matrix metalloproteinases. In addition, 
activated astrocytes and migrating meningeal fibroblasts 
at the injury site contribute to the development of fibrosis 
in the affected area. As a result, the formation of a glial scar 
occurs, which ultimately impedes axon growth and 
recovery, leading to poor healing after spinal cord injuries. 
The current study on RKI-1447, a powerful inhibitor of 
ROCK 1 and ROCK 2, highlights its potential as part of a 
new class of drugs for treating various eye conditions like 
ocular hypertension. It also shows promises in reducing 
the migration, invasion, and anchorage-independent 
growth of breast cancer cells.18 
Since Rho pathways play a significant role in spinal cord 
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injuries (SCI), inhibiting these pathways may aid in SCI 
recovery. Although RKI-1447 is an effective Rho pathway 
inhibitor, it has not yet been tested for SCI treatment 

Reactive Astrocytosis (Glial Scar Outer Core) 
Astrocytes showing positive GFAP staining were counted 
within a 1200 µm area extending from the injury centre on 
both sides, using immunohistochemical methods. We 
found a significant difference in the number of reactive 
astrocytes between the RKI-1447-treated and non-treated 
groups. Our research also demonstrates the effectiveness 
of RKI-1447 at both doses (0.6 µg/kg/day) and lower (0.3 
µg/kg/day) doses, over periods of 7th, 14th and 28th days. 
Notably, the higher dose administered for longer time 
resulted in a more significant reduction in reactive 
astrocyte counts after spinal cord injury compared to the 
lower dose at 28 days post-injury. Upon reviewing existing 
literature, we did not find any studies that specifically 
calculated and compared reactive astrocytes in RKI-1447 
treated and non-treated rats with compression spinal cord 
injury.  
Our findings are consistent with those of Yamazaki K and 
colleagues, who reported the anti-inflammatory effects of 
FTY720. Their study demonstrated that FTY720 mitigated 
local inflammatory responses and reduced glial scar 
formation by influencing reactive astrocytes in rats with 
compression spinal cord injuries. Specifically, the area 
with GFAP-positive reactive astrocytes, located 4 mm 
caudal to the injury site, was significantly smaller in the 
FTY720-treated group compared to the vehicle-treated 
group.19 
The results of the current study are like those of a recent 
investigation, particularly in terms of the anti-
inflammatory effects of RKI-1447 and alendronate. The 
study observed that alendronate exhibited anti-
inflammatory properties by reducing inflammatory 
responses in a spinal cord injury (compression model). 
Specifically, it found that GFAP-positive reactive 
astrocytes were present in both the control group and rats 
with spinal cord injuries treated with either a vehicle or 
alendronate. However, the number of reactive astrocytes, 
as indicated by GFAP positivity, was significantly lower in 
the spinal cord injury group treated with alendronate 
compared to the group treated with the vehicle on day 28 
post-injury.20 
The study concluded that CCIII functions as an anti-
inflammatory agent by reducing the expression of TNF-α, 
COX2, and CD68, as well as an anti-fibrotic agent by 
inhibiting MMP-9. Statistically significant differences were 
found in the GFAP-positive reactive astrocytes between 
the SCI+CCIII, SCI+ Riluzole, and sham groups. Both the 
SCI+CCIII and SCI+ Riluzole groups showed a notable 
decrease in reactive astrocytes on the seventh day after 
the injury compared to the sham groups.21 
Additionally, our study supports the findings of Kang S et 
al. (2018), who established the anti-inflammatory and 
neuroprotective effects of Baicalin in a rat compression 
spinal cord injury model. Their research demonstrated 
that Baicalin reduced the levels of TNF-α, IL-1β, and IL-6. 
Statistically significant differences in the number of GFAP-
positive reactive astrocytes were found between the SCI 
group and the Baicalin-treated group. The Baicalin-treated 

rats, particularly those in the higher-dose group, exhibited 
a significant reduction in GFAP-positive reactive 
astrocytes compared to the SCI group 30 days after the 
injury.22  
The study showed a notable reduction in GFAP-positive 
reactive astrocytes in the curcumin-treated group 
compared to both the control spinal cord injury group and 
the methylprednisolone-treated group. These findings are 
consistent with the work of Lin B et al. (2014), who 
explored the anti-inflammatory effects of U0126 in a rat 
spinal cord contusion model. Their research demonstrated 
a reduction in glial scar formation and enhanced 
sensorimotor recovery following spinal cord injury. 
Additionally, their study found a significant decrease in 
GFAP-positive reactive astrocytes in the U0126-treated 
group compared to the control group. However, 28 days 
after spinal cord injury, the number of GFAP-positive 
reactive astrocytes was lower than at 14 days in both the 
U0126-treated and non-treated groups.23  

Axonal Growth/Sprouting 
GAP-43 positive axonal growths/sprouts were assessed 
within the injury lesion using immunohistochemistry. A 
significant difference in axonal growth was observed 
between the RKI-1447 treated and non-treated groups. 
Our research highlights the effectiveness of RKI-1447 at 
both a higher dose of 0.6 µg/kg/day and a lower dose of 
0.3 µg/kg/day, across both 14- and 28-day treatment 
periods. However, the higher dose and longer treatment 
duration of 28 days resulted in a greater degree of axonal 
sprouting compared to the lower dose and shorter 14-day 
period. These findings suggest that RKI-1447 promotes 
axonal regeneration following spinal cord injury. 
After reviewing the available literature, we found no 
studies that specifically measured and compared axonal 
growth or sprouting in rats with spinal cord compression 
injuries, both with and without RKI-1447 treatment.  
Our findings are consistent with a recent study by 
Chandran P and his team, who assessed the potential of an 
ethanolic extract from Mucuna Pruriens (MP) as an anti-
inflammatory and antioxidant agent. This study aimed to 
evaluate its effectiveness in alleviating neurological 
impairments following weight-drop contusion spinal cord 
injuries in rats. The results showed a significant difference 
in GAP43 mRNA levels, as measured by real-time PCR, 
between the MP-treated group and the SCI model group. 
Specifically, the GAP43 mRNA levels were higher in the 
MP-treated group compared to the untreated SCI group 10 
weeks after the injury, highlighting the efficacy of the 
ethanolic extract of Mucuna Pruriens in promoting axonal 
regeneration following spinal cord injury.24  
The current study is supported by a recent investigation 
where researchers demonstrated the neuroprotective and 
anti-inflammatory effects of Aucubin in a rat model of 
spinal cord injury induced by clip compression. The results 
revealed a significant difference in GAP-43 expression at 
the injury site between the Aucubin-treated group and the 
SCI model group, as observed through 
immunofluorescence. GAP-43 positive regions were 
notably more prominent in the Aucubin-treated group 
compared to the untreated SCI group on days 7, 14, and 28 
post-injuries, suggesting Aucubin's role in promoting 
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axonal regeneration following spinal cord injury.25  
Our research is similar to the work of Liu X and colleagues, 
who investigated the potential of Resveratrol in a rat 
contusion model of spinal cord injury. Their findings 
highlighted Resveratrol's anti-inflammatory, antioxidant, 
anti-apoptotic, and neuroprotective properties, which 
align with the objectives of our study. The results indicated 
a significant difference in GAP-43 intensity at the injury 
site between the Resveratrol-treated group and the SCI 
model group, detected through immunohistochemistry. 
GAP-43 positive regions were much more pronounced in 
the Resveratrol-treated group compared to the untreated 
SCI group on days 14 and 35 post-injury, further 
confirming Resveratrol's effectiveness in supporting 
axonal regeneration after spinal cord injury.26  

The results of this study further corroborate previous 
research demonstrating that Baicalin has anti-
inflammatory and neuroprotective effects, as evidenced by 
its ability tom reduce levels of TNF-α, IL-1β, and IL-6 in a 
rat model of compression spinal cord injury. The study 
found a statistically significant difference in GAP-43 
expression between the SCI group and the Baicalin-treated 
group. Rats treated with Baicalin showed a notable 
increase in GAP-43 expression, particularly in the high-
dose group, compared to the SCI group, on day 30 after the 
injury.27       

Neuronal Sustainability 
Nau N positive viable neurons were examined and counted 
inside the injury lesion. We observed no viable neuron in 
the injury lesion of any group. Therefore, no statistical 
evaluation was performed. However, we have noticed 
traces and residues of neuronal cell bodies in the injury 
lesion of all groups. There was obvious difference in the 
number of neuronal residues between RKI-1447 treated 
and non-RKI-1447 treated groups.  
Our study also unveils the efficacy of RKI-1447 in a higher 
dose of 0.6 µg/kg/day as well as in lower dose of 0.3 
µg/kg/day in 7th ,14th and 28th days duration. However, 
higher dose and in 14 days duration, RKI-1447 showed 
more neuro-protective effect by slowing down the 
neuronal apoptosis/degeneration in injury lesion after 
spinal cord injury as compared to lower dose and in 28 
days post-injury duration. This shows the efficacy of RKI-
1447 in decelerating the process of neuronal degeneration 
and apoptosis after spinal cord injury. 
After conducting a thorough review of the existing 
literature, no studies were discovered that had calculated 
and compared the presence of viable neurons in rats with 
spinal cord compression injuries, distinguishing between 
those treated with RKI-1447 and those not treated with 
RKI-1447.  
The outcomes of our current research align with those of a 
previous study, wherein researchers illustrated the 
efficacy of a solitary RKI-1447 dose in mitigating neuronal 
degeneration. This was accomplished by reducing lipid 
peroxidation in the rat hippocampal region after kainic 
acid-induced toxicity. Fluoro-Jade B staining 72 hours after 
treatment revealed a significant difference in the 
degenerating neurons between the groups treated with 0.6 
µ mg/kg RKI-1447 and other SCI/lower dosage groups. 
Rats given a dosage of 0.3 µg/kg had more surviving 

neurons than rats in other groups.28  
The present investigation is supported by a recent study 
carried out by Wang C and colleagues. Their study 
showcases the efficacy of a bioactive, versatile citrate-
based hydrogel therapeutic system that enables an 
extended release of extracellular vesicles derived from 
mesenchymal stromal cells (referred to as FE@EVs). This 
system serves as a promising treatment strategy for 
mitigating fibrosis and inflammation, ultimately 
facilitating the restoration of both functional and 
structural aspects following a complete transection spinal 
cord injury. The study results showed statistically 
significant difference in neuronal apoptosis in FE@EVs 
treated group as compared to other groups, indicated by 
MAP-2 immunofluorescence staining on 21, 35, 49 and 56 
days post injury. FE@EVs treated group proved significant 
reduction in neuronal degeneration compared with other 
groups.29  

In a rat model of spinal cord injury, they accomplished this 
by lowering the expression levels of COX-2, TNF-α, IL-1β, 
and IL-6. Their study results revealed that myelination in 
spinal cord white matter and motor neuron number in grey 
matter was significantly conserved in astaxanthin treated 
rats as compared to the control group rats. Our present 
research investigation is corroborated by a recent study 
that delineated the protective effects of intrathecally 
administered naringenin on neurons in the dorsal and 
ventral regions of the spinal cord following spinal cord 
injury induced by aneurysm clip compression in rats, 
emphasizing its anti-inflammatory and antioxidant 
properties. Statistically significant difference in viable 
neurons in both dorsal and ventral horns was noted in 
between the naringenin treated group and control spinal 
cord injury group on day 28 post SCI.30 
The current findings from our research exhibit 
resemblances with a previous study that demonstrate that 
the anti-inflammatory and antioxidant properties of 
Selenium-doped carbon quantum dots (Se-CQDs) in a rat 
model of contusion spinal cord injury. According to a 
study, one of the main causes of subsequent damage in the 
injured spinal cord is the increased production of ROS 
(reactive oxygen species) following spinal cord injury. Se-
CQDs could scavenge ROS. The study results show a 
statistically significant difference in the viable neurons at 
the lesion site in between Se-CQDs treated group and 
saline treated group. Se- CQDs treated group showed 
significantly higher number of neurons at lesion site as 
compared to saline treated group, detected by anti-Nue N 
immunofluorescence technique after 08 weeks of injury.31 

 

CONCLUSION 
A suitable model for rodents is a laboratory rat with spinal 
cord injury. Globally, they are widely used for translational 
research pertaining to SCI. Laboratory rats have been used 
to develop and test a variety of surgical techniques, 
including compression, contusion, and transection models.  
Since the purpose of pre-clinical research is to get ready 
for clinical scenarios, it is critical to replicate all 
controllable factors as closely as possible in order to 
guarantee successful therapeutic translation. It will be 
challenging to successfully replicate any noteworthy 
advancements made in pre-clinical trials in SCI patients if 
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this is not accomplished. Currently, the majority of pre-
clinical SCI models do not account for many of the 
variables that may influence how the body reacts to spinal 
cord trauma, such as age, sex, drug use before and after 
injury, and head trauma. Clinical trials for SCI will fail more 
frequently if pre-clinical animal models don't accurately 
reflect the clinical environment. 
The accuracy of investigations depends on selecting the 
right SCI model. All behavioral tests must be universal, 
authentic, and reliable in order to be considered valid. In 
addition to illustrating various models and assessing 
spinal injury tests, this article discusses selection criteria, 
benefits, and drawbacks. 

Recommendation 
Traumatic spinal cord injury is a ruinous condition that 
leaves most of the victims with everlasting neurological 
deficits. Glial scar formed following spinal cord injury is 
considered to be one of the main factors that makes 
hindrance and unfavorable conditions for axonal growth 
and neurological recovery. In response to inflammatory 
mediators after spinal cord injury, meningeal fibroblasts 
activation and migration towards the injury site play role 
in establishing central fibrous core of glial scar. 
Furthermore, astrocytes become hypertrophic, 
proliferate, remodel and express an overexpression of 
GFAP, forming the outer core of the glial scar. These 
migrated meningeal fibroblasts and proliferated 

hypertrophic reactive astrocytes are mainly responsible 
for secreting collagen fibers and other fibrotic components 
like extra cellular matrix in the glial scar. 
According to the results of our study, RKI-1447 
demonstrates the RhoA/Rho kinase pathway, which is 
triggered by a variety of signals and sets off a chain of 
subsequent events that lead to functional deficits, such as 
inflammation, neuropathic pain, demyelination, cell death, 
and axon degeneration. Can effectively reduce the 
formation of glial scars following spinal cord injuries. This 
is achieved by inhibiting the activation and migration of 
meningeal fibroblasts, as well as the proliferation and 
reactivation of astrocytes. As a result, RKI-1447 creates a 
conducive environment that facilitates axonal 
regeneration, leading to enhanced neurological recovery 
characterized by improved sensory and motor functions. 
In order to improve the aftermath of secondary injury 
mechanisms and to modulate and rehabilitate the 
neuropathological process involved, the compression 
model can demonstrate its suitability for preclinical 
testing of novel therapeutic approaches in patients who 
are paralyzed or quadriplegic.  
Clinical research must have suitable experimental plans to 
successfully demonstrate novel interventions for SCI. 
However, for the sake of ethics, animal welfare, and the 
acceptance of its results, the three Rs should be taken into 
account.
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